Overview

This Lab Guide contains the exercises for Using HP ALM of HP ALM 11 Essentials training. The labs are designed to enhance the knowledge you will gain from the instructor’s presentation of each topic.

Exercise Outline

Each exercise will define the user role or roles you will be simulating in order to complete the exercise objective. Sample roles include: Tester, Developer, QA Manager and Business Analyst. The exercise objective will also be defined. The exercises are structured to help guide you through the objective without providing step by step instructions.
Overview ................................................................. 1
Exercise Outline ...................................................... 1
Working with Releases .............................................. 3
  Review Questions .................................................. 3
  EXERCISE .......................................................... 4
Project Planning and Tracking ................................. 6
  Review Questions .................................................. 6
  EXERCISE .......................................................... 7
Requirements Management .................................... 11
  Review Questions .................................................. 11
  EXERCISE .......................................................... 12
Analyze Requirement Risks ..................................... 15
  Review Questions .................................................. 15
  EXERCISE .......................................................... 16
Business Models ..................................................... 18
  Review Questions .................................................. 18
  EXERCISE .......................................................... 19
Test Planning .......................................................... 22
  Review Questions .................................................. 22
  EXERCISE .......................................................... 23
Test Execution ........................................................ 28
  Review Questions .................................................. 28
  EXERCISE .......................................................... 29
Manual Testing with Sprinter ................................. 32
  Review Questions .................................................. 32
  EXERCISE .......................................................... 33
Defect Tracking ....................................................... 34
  Review Questions .................................................. 34
  EXERCISE .......................................................... 35
Using Version Control .......................................... 38
  Review Questions .................................................. 38
  EXERCISE .......................................................... 39
Library Management .............................................. 41
  Review Questions .................................................. 41
  EXERCISE .......................................................... 42
Sharing Libraries ................................................... 45
  Review Questions .................................................. 45
  EXERCISE .......................................................... 46
Reporting and Analysis ......................................... 48
  Review Questions .................................................. 48
  EXERCISE .......................................................... 49
Working with Releases

Review Questions

1. What does the Required execution rate in the Release Progress tab indicate?
   a. The execution rate of tests that have been completed for the Release.
   b. The execution rate of tests that have been completed for each cycle.
   c. The execution rate of tests needed to complete the tests before the Release end date.
   d. The execution rate of tests needed to complete the tests before each cycle end date.

2. Which rule applies to Cycle dates?
   a. A cycle end date can begin later than the release end date.
   b. A cycle start date can begin before the release start date.
   c. A cycle start date can begin before the previous cycle ends.
   d. A cycle start date cannot begin before the previous cycle ends.

3. How do you copy a cycle?
   a. Select the new cycle and select the cycle to copy in the New Cycle dialog.
   b. You cannot copy a cycle
   c. Right-click on the cycle and select Copy, then paste
   d. Right-click on the cycle and select Duplicate Cycle
EXERCISE

User Role:

- Project Manager
- QA Manager

License Type:

- Enterprise
- ALM

Objectives:

- Define a new release
- Define cycles
- Reschedule release

Release 4.0 of the OnlineBanking application has been approved, and requirements are being defined. The quality of the release will be managed in ALM. The release and cycles are defined in the Management module.

Login to ALM

1. Select the ALM 11 icon on the desktop to launch ALM.
2. Select the Application Lifecycle Management link.
3. Authenticate as:
   - Username: alex_adm
   - Password: training
4. Select the domain Training and project OnlineBanking and login.

Creating a Release

1. Expand the options of the Management menu.
2. Select Releases
3. Use the mouse-over feature of ALM to identify the icon used to create a new folder, or access the New Release Folder option from the Releases menu. Create a new folder called Banking.
4. With the new folder selected, add a new Release named: Banking 4.0. Use today’s date as the Start Date. Define the End Date three months from today.
Define Cycles

1. Locate the New Cycle icon. Add the four cycles defined in the table below.

2. Define the first cycle with today’s date as the Start Date. Use the duration to determine the End Date. (Note: Date precision is not critical for the exercises).

3. Define each subsequent cycle to begin the Monday after the previous cycle.

<table>
<thead>
<tr>
<th>Cycle Name</th>
<th>Description</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle 1-New Features</td>
<td>This cycle tests new features in Release 4.0 of the OnlineBanking application.</td>
<td>4 weeks</td>
</tr>
<tr>
<td>Cycle 2-Integration</td>
<td>This cycle tests the new features with existing features which may have been impacted by the changes.</td>
<td>3 weeks</td>
</tr>
<tr>
<td>Cycle 3-Performance</td>
<td>Once application functionality has been tested, this cycle measures the performance of critical screens and business processes to ensure the new features have not negatively affected response time.</td>
<td>3 weeks</td>
</tr>
<tr>
<td>Cycle 4-User Acceptance</td>
<td>This cycle ensures that the new features expectations of the business.</td>
<td>3 weeks</td>
</tr>
</tbody>
</table>

Reschedule the Release

After defining the release dates, it has been decided that additional features will be added, so the release date has been extended.

1. How can you modify the release End Date?

2. How can you modify the cycle dates?

3. Extend the release date by 4 weeks.

4. Modify the start and end date of each cycle to account for the additional 4 weeks.

5. Make a note of the start and end dates for the first cycle. You will need this in the next exercise.
Project Planning and Tracking

Review Questions

1. How can the Due Date of a milestone be modified?
   a. Edit the milestone and change the date manually.
   b. Use the Reschedule option.
   c. Milestone dates cannot be changed.
   d. Use the Master Plan and drag the Milestone icon to the new date.

2. What are the two types of KPIs?
   a. Calculated and Percentage
   b. Percentage and Custom
   c. Count and Percentage
   d. Warning and Error

3. What is a Scope Item?
   a. A performance indicator
   b. Another name for a milestone
   c. An item used to manage KPI thresholds
   d. A key feature of the release
EXERCISE

User Role:

- Project Manager
- QA Manager

License Type:

- ALM

Objectives:

- Define Scope Items and Content
- Define Milestones
- Define Milestone Scope
- Define KPIs
- Define Thresholds

The Project Planning and Tracking feature is being implemented for Release 4.0. Milestones, Scope Items and KPIs need to be defined at the beginning of the release so the KPI status can be tracked throughout the release. This exercise will guide you through the PPT configuration. We will then revisit the calculations later in this training after we have created and processed additional release content.

Define Scope Items and Content
1. Continue to work in the Releases Module where you completed the previous exercise.

2. Highlight the Banking 4.0 item you created in the previous exercise.


4. Add three Scope Items listed in the table below: (use mouse over if you need help finding the icon used to add items.)

<table>
<thead>
<tr>
<th>Scope Item</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interactive Statements</td>
<td>3-High</td>
</tr>
<tr>
<td>Goal Based Savings</td>
<td>3-High</td>
</tr>
<tr>
<td>Debit Rewards</td>
<td>3-High</td>
</tr>
</tbody>
</table>

5. Assign content to each Scope Item. Content is added using the Content tab at the bottom of the Release Scope tab.

6. Select each Scope Item and expand the Requirements tree to locate the folders as shown below:

7. Add Tests and Test Sets. Tests should be selected by coverage and Test Sets are selected by tests they contain. HINT: look at the Radio buttons for each of these Content tabs.
8. Defect content is best added by using a filter. Select the Define filter link.
9. Locate Scope Items in the Field Name column.
10. Click on the down arrow of the Field Condition column. Select the corresponding Scope Item you are currently adding content for.
11. Repeat steps 8 thru 10 for each Scope Item.

Define Milestones

The Project or Quality Manager would define all the milestones for the project. To expedite the exercise we will create just a single Milestone and completely configure it with KPIs to demonstrate this feature.

1. Highlight the Banking 4.0 release so the New Milestone icon will be enabled.
2. Add a new Milestone called New Features Test Complete (this aligns with the first Cycle you created in the previous exercise.
3. Enter today’s date as the Start Tracking Date.
4. Enter the same End Date you used for Cycle 1
   
   **Note**
   The Cycle and Milestone may not always correspond as we have defined in this exercise. Commonly a milestone will include several cycles.

Define Milestone Scope

1. Highlight the milestone you just created.
2. Select the Milestone Scope tab.
3. Click the Select button to add all Scope Items the Milestone you just created.

   **Note**
   You can add the scope items one at a time or use the shift-click to highlight and add them at once.

Define KPIs

1. Continue working with the same milestone.
2. Select the KPIs tab.
3. Click the Add KPI button to view the list of available KPIs.
4. Add the following KPIs:
   a. Passed Tests
   b. Tests Executed
c. Severe Defects

Define Thresholds

1. Close the KPIs window so the Threshold Preview can be seen. (see above).
2. Select the Passed Tests KPI column.
3. In the Thresholds table below, click the Add Threshold Value button.
4. Enter a date midway between the default Start and Due dates shown for this threshold. Enter 50 for the % OK Above. Click OK to save the Threshold.
5. Change the % OK Above of the existing Start threshold to 0. (Click in the cell to change a value – the response to make this editable may have a slight delay).
6. Repeat steps 3 thru 5 for the Tests Executed KPI.
7. The Severe Defects KPI does not use a percentage KPI, it uses a count KPI. Since we might expect defects to rise early in the timeframe of the milestone, the threshold values are different. After adding a new midway date for Severe Defects, set the following thresholds:
   a. Change the % OK Below for the Start Date to 15.
   b. Change the %OK Above for the Due Date to 5.
   c. Change the %OK Above for the midway date you added to 30.

Note
We will revisit the calculations later in this training after we have created and processed additional release content.
Requirements Management

Review Questions

1. Which requirement status is determined by the status of the test associated with it?
   a. Requirement Status
   b. Direct Cover Status
   c. Indirect Cover Status
   d. Association Status

2. Which Requirement View should you use to update multiple records at once?
   a. Tree View
   b. Detail View
   c. Grid View
   d. Multiple records cannot be updated

3. Where can the relationship of requirements to other requirements and requirements to tests be evaluated.
   a. Test Coverage tab
   b. Req Coverage tab
   c. Coverage Analysis
   d. Traceability Matrix
EXERCISE

User Role:
- Project Manager
- QA Manager

License Type:
- Starter – Test Requirements only
- Enterprise
- ALM

Objectives:
- Explore requirements views
- Define a functional requirement
- Add rich text to a requirement
- Assign requirements to release and cycles
- Define requirement traceability
- Create a traceability matrix

Explore Requirements Views

1. Expand the Requirements menu.
2. Select the Requirements module.
3. Select the View menu and select the Requirements Grid view.
4. Continue to select and review each view.
5. Which view would provide the best option to filter by a specific Author?

6. Make a note about what you see when you select the Coverage Analysis view. We will revisit this view in a later exercise.

Define a functional requirement

1. Select the Requirement Details View
2. Expand the Banking → Goal Based Savings folder. Place the cursor on the Goal Based Savings folder name.

3. Add a new requirement. HINT: Use the mouse over to locate the icon or the right-click menu.

4. Define the new requirement as Change Goals

5. Select Functional from the Requirement Type list.


Add Rich Text to a requirement

1. Select the Change Goals requirement you just created.

2. Select the Rich Text tab.

3. Enter the content so it appears in the sample below:

```
<table>
<thead>
<tr>
<th>Change Goals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functional Specification</td>
</tr>
<tr>
<td>Revised by</td>
</tr>
<tr>
<td>--------------</td>
</tr>
</tbody>
</table>
```

Assign requirements to Releases and Cycles

1. Change to the Requirements Tree view.

2. Identify the Select Columns icon and select it.

3. Select the Target Cycle and Target Release and add them to the Visible Columns list. Return to the Tree View where the new columns should now be visible.

4. Select the Banking Folder requirement and right click. Select the Assign to Cycle option.

5. Expand the Tree until you see the list of cycles you created. Select Cycle 1 – New Features and Click OK. When prompted, select the option to apply to all sub requirements.

6. Confirm the Target Release and Cycle are now defined for the Banking folder requirements.
Define Requirement Traceability

1. Change to the Requirement Details view.
2. Expand the Profile Maintenance folder.
3. Select the Login requirement.
4. Select the Requirement Traceability tab.
5. Many requirements are impacted by the Login requirement. To define this relationship, they are added to the Trace To list. Click the Add Requirement Traceability button to see the list of requirements.
6. Use Drag/Drop to add the following requirements to the Trace To list:

   - Banking → Goal Based Savings → Define Goals
   - Banking → Debit Rewards → Enroll
   - Banking → Debit Rewards → Notification

Create a Traceability Matrix

1. Change to the Traceability Matrix view.
2. Click the Configure Traceability Matrix option or create a configuration link.
3. Access the filter details for the source requirement. (Click the Set Filter/Sort icon).
4. Locate Name in the Field Name column. Enter Login in the Filter Condition. This establishes the Login as the requirement we will view the relationships for. Click OK to close the filter.
5. Select the Filter by linked requirements option.
6. Check the Filter by linked requirements check box and select affecting from the Include source requirements dropdown. Leave all other defaults.
7. Click OK to complete this configuration and confirm the three requirements you traced to Login are displayed.
8. Click the Generate Traceability Matrix button to create a spreadsheet. Save this to the Desktop.
Analyze Requirement Risks

Review Questions

1. What two components are defined to determine the Risk calculation?
   a. Functional Complexity and Difficulty Rating
   b. Business Criticality and Failure Probability
   c. Change Frequency and Defect Ratio
   d. Requirement Assessment and Test Coverage

2. What are the Analysis Constants used to determine?
   a. Which requirements to exclude from the assessment
   b. The types of requirements to include in the assessment
   c. The questions used for Risk Assessment
   d. Testing time and Testing levels
EXERCISE

User Role:
- QA Manager
- Business Analyst

License Type:
- Enterprise
- ALM

Objectives:
- Review Risk Assessment
- Add Risk Definitions
- Calculate Risk

In this exercise we will review the Risk Assessment that has already been analyzed for the Goal Based Savings requirements. In addition we will add the risk definitions for the new requirement we added to this section in the previous exercise. Finally the calculations will be run again to determine if any adjustments are needed since adding the new requirement.

Review Risk Assessment
1. Change to the Requirements Detail view.
2. Select the Banking → Goal Based Savings folder.
3. Click the Risk Analysis tab. (You may have to scroll the tabs to the right).
4. Review the Analysis results:
   How many assessments are missing? ............................................................
   What percent of testing time is covered? .......................................................

Add Risk Definitions
1. Select the Change Goals requirement you added in the previous exercise.
5. Select the Assessment Questions tab within the parent Risk Assessment tab.
Calculate Risk

1. Return to the Goal Based Savings folder requirement.
2. Click the Analyze button to re-Analyze the requirement group.
3. How did your answers impact the results?
   ........................................................................................................................................
4. How can you manually override the calculation for a specific requirement?
   ........................................................................................................................................
Business Models

Review Questions

1. What edition(s) is the Business Model module available in?
   a. ALM and Enterprise
   b. All
   c. ALM only
   d. Enterprise only

2. What model notations are able to be imported to ALM?
   a. BPMN and RUP
   b. EPC and RUP
   c. Any model type
   d. BPMN and EPC

3. What Business Model feature can be added to verify the quality of a business process?
   a. Model Report
   b. Activity
   c. Path
   d. Representative Requirement
EXERCISE

User Role:
- Project Manager
- Quality Manager
- Business Analyst
- Quality Analyst

License Type:
- Enterprise
- ALM

Objectives:
- Import a business process model
- Explore the business process model
- Create a new path
- Link an activity to a requirement
- Analyze the status

Importing a business process model

1. Navigate to the Business Models module in the Requirements section of the ALM sidebar.
2. Create a new model folder named Banking.
3. Select the Import Model icon and use the From file selection to browse for the import file.
4. The file is in the Enablement → QC → BPM folder located on the Desktop.
5. Select the Transfer Funds.xpdl file and click Import. When the import is finished click OK.

Explore the business process model

1. In the Model Tree, expand the Transfer Funds model. This displays a list of Activities included in the model.
2. Click the Activities listed in the model. Observe how this affects the graphical models on the right.
3. You can zoom in and out to adjust the size. In the model diagram, use the Ctrl-[plus] and Ctrl-[minus] keys to zoom in and zoom out. Or, right-click and select **Zoom In** and **Zoom Out**.

4. Another way to navigate the model is by using the mini-map. Locate the mini-map in the lower left corner of the window. Drag a rectangle around an area within the mini-map, then drag or resize the frame to change the focus.

5. After importing a model, a folder is also added to the Requirements module. Go to the **Requirements** module and click the **Refresh** icon. Expand the Business Model folder and review the **Activities** that were added.

6. Return to the **Business Models** module.

**Creating paths**

Paths are created by the user. They represent logical flows through the business process. They can serve as the basis for testers to define end-to-end test plans.

1. In the Model Tree, right-click the **Transfer Funds** model, and select **New Path**. The New Model Path dialog opens.

2. Maximize the **New Model Path** dialog. Notice the Description, Comments, and Path Description tabs in the lower pane. During import ALM analyzes the business model and identifies all the possible flows through the business process.

3. Select the **Path Description** tab. This tab provides a textual description of the sequence of activities in the selected path.

4. Enter **Main Transfer Flow** as the **Name** of the path.

5. In the Details tab, select the path 1 → 2 → 6 → 3 → 4 → 5.

   **Note**
   
   Selecting a path from the list causes the path to display in orange in the diagram. You can also zoom in on the diagram or mouse over the activities.

6. Click OK to save the path. Your new path now appears in the Model Tree at left.

**Linking model entities to a requirement**

The owner of the business model may want to analyze the project from a business model perspective. To achieve this, the requirement and test entities need to be linked to the model. In this example we will link a requirement.

1. Select the **Transfer Amount** activity.

2. Click the **Linkage** tab (below the model graphic).
3. Click the **Select Requirements** button. The Requirements Tree opens on the right.

4. Expand the tree to locate: Requirements → Banking → Accounts → Transfer Funds → Account Transfer. Add this requirement.

### Analyze status based on the business process model

With linkages in place, you can now analyze the quality status of the project from the business model perspective.

1. You view quality status in the Model Analysis view. Select **View → Model Analysis** from the Business Models menu.

2. Click the **Quality Analysis** tab, and assure the following settings:

3. Click the **Generate** button.

4. View the graphs.

**Note**
Since we are in the early stages of defining our release the Quality Analysis is limited. As the release progresses the content will become more meaningful to the analyst or manager.
Test Planning

Review Questions

1. What does "<<value>>>" represent when found in the design steps?
   a. Called test
   b. Template
   c. Parameter
   d. Configuration

2. As you create tests for the requirements, you discover there are four requirements which can be tested using the same test using two parameters. If you create a new test configuration for each requirement, how many total configurations will you have for this test?
   a. 5
   b. 10
   c. 4
   d. 8
EXERCISE

User Role:
- Business Analyst
- Quality Analyst

License Type:
- Starter
- Enterprise
- ALM

Objectives:
- Convert requirements to tests
- Create a new manual test
- Link a test to a requirement
- Add parameters to a manual test
- Define test configurations
- Link test configurations to requirements
- Review coverage

Convert Requirements to Test Plans

HP ALM can automatically convert your requirements into tests using a wizard that maps requirements to subjects, tests, or test steps.

1. Confirm you are logged into the OnlineBanking project as user - alex_adm, password - training.
2. Select the Requirements module.
3. From the requirements tree, right-click on the Requirements → Banking folder. Select Convert to Tests.
4. In the Choose an automatic conversion method dialog box, select the second option button to Convert the lowest child requirements to tests. Click Next.
5. Observe the test plan structure in the Manual changes to the automatic conversion dialog box that results from the conversion.
6. Continue through the Wizard using defaults to complete the conversion.
7. Select some of the Requirements you just converted and select the **Test Coverage** tab. Are the tests linked to their corresponding requirements?

Create a new test

In addition to automatically creating tests from requirements, you can manually create tests by specifying the exact steps to follow. This process is also helpful for cleaning up tests that were automatically mapped from requirements, as sometimes the mapping process may not produce the desired results.

1. Select the **Testing** menu and select the **Test Plan** module.
2. Expand the **Banking → Statements** folder.
3. Add a new **Manual** test named **View Summary**
4. Click OK to complete the Add.
5. Select the **Design Steps** tab.
6. Add a new step using the **New Step** button.
7. Add the following information in the Description and Expected Results fields:

<table>
<thead>
<tr>
<th>Description</th>
<th>Expected Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Welcome page displays</td>
</tr>
</tbody>
</table>

8. Remain within the Design Step Details dialog and click the New Step button to add the additional steps below:

<table>
<thead>
<tr>
<th>Description</th>
<th>Expected Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the savings account from the dropdown list</td>
<td>Savings account is selected</td>
</tr>
<tr>
<td>Click the View Summary button</td>
<td>Savings account summary opens in a new window</td>
</tr>
</tbody>
</table>

9. Click OK to complete the addition of steps

Link a Test to a Requirement

1. Confirm the new **View Summary** test is selected.
2. Click the **Req Coverage** tab.
3. Click the **Select Req** button.
4. Locate the **View Current** requirement in the **Statements** folder.
5. Select the option to **Add to Coverage (without children)**.

6. This test should now be linked to the requirement.

**Modify and Parameterize the Login Test**

The login test was created too vague. We need to add steps and parameterize the test so it will be more useful and effective for testing.

1. Locate the Login test in the Banking → Profile Maintenance folder.
2. Select the Design Steps tab.
3. Locate the Edit Step icon to modify Step 1.
4. Change and add steps so the Login test contains the following:

<table>
<thead>
<tr>
<th>Description</th>
<th>Expected Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter username</td>
<td>Username displays as typed.</td>
</tr>
<tr>
<td>Enter password</td>
<td>Password encryption is displayed as * for letters typed.</td>
</tr>
<tr>
<td>Click Login button</td>
<td>Welcome page displays</td>
</tr>
</tbody>
</table>

7. Click OK to complete the addition of steps.

**Note**

A powerful feature of automated testing is the ability to use the same test for different sets of data. Parameterization of user input takes advantage of that feature, and saving a test as a template allows it to be reused, providing additional flexibility.

8. Select the **Enter User Name** step and click the **Edit Step** button.
9. Delete the text *user name* in the **Description** field. Without moving the cursor, click the **Insert Parameter** button.
10. Click the New Parameter button and define a parameter called **UserName**. Click OK.
11. Add another parameter called **Password**.
12. Place the cursor on the **UserName** parameter and click OK. The **UserName** parameter should be added to your description surrounded by <<< >>>.
13. Close that step and edit the **Password** step.
14. Delete the text *password* in the **Description** field. Without moving the cursor, click the **Insert Parameter** button.
15. Select the existing **Password** parameter you already created and click OK.
16. The **Password** parameter should be added to your description surrounded by <<< >>>.

Define Test Configurations

Test Configurations allow us to execute the same manual test to achieve different test results. In this exercise we will create new configurations to test logins that will receive different information based on the type of account they have.

1. Confirm the Login test is still selected.
2. Select the **Test Configurations** tab. You will see a test configuration called **Login** is already defined. One configuration is created by default for every test.
3. Create a **New Test Configuration**.
4. Enter **Gold** in the **Name** field and click **OK**.
5. Create another **New Test Configuration**.
6. Enter **Green** in the **Name** field and click **OK**.
7. You should now have three test configurations.
8. Highlight the **Gold** configuration
9. Select the **Data** tab below the configurations.
10. Highlight the username and add **goldname** in the **Actual Value** field.
11. Add **goldpass** as the **Actual Value** for the password.
12. These are the values that will be used when this configuration is run in the test lab.
13. Repeat steps 8 thru 12 to add **greenname** and **greenpass** as the username and password for the **Green** test configuration.

Link Test Configurations to Requirements

1. Confirm the **Login** test is still selected.
2. Click the **Req Coverage** tab.
3. Click the **Select Req** button (if the Requirements are already displayed, this button is not enabled).
4. In the **Requirement Tree**, select the **Login** requirement found in the **Profile Maintenance** folder. You will be prompted to Add Configuration Coverage. Select the **Login** configuration.
5. Repeat steps 6 and 7 to link the **GoldAccounts** requirement to the **Gold** configuration.
6. Repeat steps 6 and 7 to link the **GreenAccounts** requirement to the **Green** configuration.
Review Coverage

1. Select the **Requirements** module. Confirm you are in **Requirements Details** view.

14. Expand the **Requirements** tree to review the **Profile Maintenance** folder.

15. Select the **Login** requirement and click the **Test Coverage** tab.

16. What is the **Coverage Mode** for this test?

..................................................................................................................

17. Check the **GoldAccounts** and **GreenAccounts** requirements. Do they have the same **Coverage Mode**?

..................................................................................................................

2. Select some of the other requirements within the **Banking** folder. Why do they have a different **Coverage Mode**?

..................................................................................................................

3. Change to the **Coverage Analysis** view. How is this view different from when you viewed it in the Requirements exercise?

..................................................................................................................

..................................................................................................................
Test Execution

Review Questions

1. How can you control the test set flow to run only if the previous test is passed.
   a. Add a workflow rule
   b. Set a Failure Condition
   c. Set an Execution Condition
   d. Add the test to the grid after the test it depends on.

2. Which test option enforces tests to be run in a specific order?
   a. Manual Runner
   b. Automated Runner
   c. Sprinter
   d. All of the above

3. How can you relate a cycle to a test set?
   a. Add the cycle definition to the Test Set Details
   b. It is automatically defined based on the cycles linked to the tests
   c. Add the cycle definition to the Test Folder the test set belongs to
   d. Cycles and test sets are not related
EXERCISE

User Role:
- Quality Analyst

License Type:
- Starter
- Enterprise
- ALM

Objectives:
- Build test sets
- Add tests to a test set
- Add test configurations to a test set
- Manage test execution flow and test dependencies
- Execute a test set and create a defect

Build test sets
1. Select the Test Lab module.
2. Select the Banking folder.
4. Select the New Features folder and click the New Test Set icon.
5. Name the Test Set: Goal Based Savings
6. Create two more test sets in the New Features folder called Interactive Statements and Debit Rewards. We now have a test set for each of the Scope Items defined for this release.
7. Select the New Features folder.
8. Select Cycle 1-New Features as the Assigned to cycle value.

Add tests and test configurations to a test set
1. Select the Goal Based Savings test set.
2. Click the Execution Grid tab.
3. Click the Select Tests button.
4. Expand the Subject folder to locate the **Goal Based Savings** folder.

5. With the folder level highlighted, click the **Add Tests to Test Set** arrow icon. Confirm you want to add all the tests in the folder.

6. Locate the **Login** test in the Profile Maintenance folder.

7. At the bottom of the Test Plan Tree you should see the option to expand Test Configurations.

8. Select the **Gold** configuration and click the **Add Test Configuration to Test Set** arrow icon.

9. Close the **Test Plan Tree**.

**Configure a test set**

1. Click the **Execution Flow** tab.

2. Define the Execution Flow to look like the Diagram below:

   ![](image)

   **Important**
   Dependencies are created by clicking a test and then dragging the cursor to the test where you want to establish the relationship.

3. In addition to defining the relationship in the above diagram, the **Define Goals** test should only execute if the Gold test passes. Right-click on the **Execution Condition** to define the condition details.

4. Additional conditions are needed to only run **Track, Change or Delete Goals** tests if **Define Goals** passes.

**Execute a test set and create a defect**

In this exercise we will execute a test set using Manual Runner. This is the only execution option for users with Starter or Performance Center edition. Users of other editions have the option of using Manual/Automatic Runner or Sprinter. We will cover Sprinter in a separate chapter.

1. Click the **Run Test Set** button.

2. Select the **Automatic Runner** option to run using the **Execution Flow** you defined.

3. Click **OK** to continue.

4. Check the option to run all tests locally, then **Run All**.
5. Which test is called first?

6. When the **Manual Runner** window displays, click **Begin Run**.

   **Note**
   We are not actually going to run a test application, but will act as if the test failed.

7. Expand the dropdown for the **Fail Selected** icon and select the option to **Fail All**.
8. Click the **New Defect** icon.
9. Type **Login page failed to load** as the defect **Summary**.
10. Select **Goal Based Savings** as the Scope Item and **5-Urgent** as the **Severity**.
11. Click OK to close the Defect window.
12. Click the **End Run** icon.
13. Confirm that the remaining tests in your test set do not run as defined in your **Execution Flow** conditions.
14. Close the **Automatic Runner**.
15. Select the **Execution Grid** tab to see the status of the tests in your test set (you may need to click the refresh icon).
16. Click the Linked Defects tab to confirm the defect was saved.
Manual Testing with Sprinter

Review Questions

1. What Sprinter Tool provides the ability to capture a screen where you can add comments?
   a. Macros
   b. Data Injection
   c. Annotation
   d. Screen Capture

2. Which feature requires PowerMode be turned on?
   a. Smart Defect
   b. Data Injection
   c. Run Results Viewer
   d. Screen Capture

3. Where is the Storyboard viewed?
   a. As an attachment in ALM
   b. As an external csv file
   c. In the Run Results
   d. As a Test Resource in ALM
EXERCISE

The Sprinter exercise cannot be executed in the Surgient environment. A separate Sprinter exercise document can be provided by your instructor if you would like to work with work in your own environment. This version of the exercise works with the Mercury Tours application and would require you to create a manual test first.
Defect Tracking

Review Questions

1. What is the initial default status of a defect?
   a. Assigned
   b. Review
   c. New
   d. Open

2. What is the benefit of creating a defect during a test run either from Sprinter or the Manual/Automatic Runner?
   a. A link to the test entity is automatically created
   b. Test run details are recorded in the defect
   c. There is no benefit, they are the same
   d. Both a and b
EXERCISE

User Role:
- Quality Analyst
- Developer

License Type:
- Enterprise
- ALM

Objectives:
- Create a defect
- Update a defect
- View a linked defect
- Link a defect to another defect

Manually create a defect

There are many benefits of adding a defect during testing, either through Sprinter or the Manual/Automatic Runner, but there may be times when a defect must be added manually.

1. Select the Defects module.
2. Click the New Defect button.
3. Enter the values below for the field referenced:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>Statement truncates the account number</td>
</tr>
<tr>
<td>Scope Item</td>
<td>Interactive Statements</td>
</tr>
<tr>
<td>Severity</td>
<td>4-Very High</td>
</tr>
</tbody>
</table>

4. Submit the defect and close the New Defect window.
Update a defect

It is a common workflow that after a defect is created, a manager receives a notification and then edits the defect to assign it to be fixed. In our exercise for the sake of time, we will edit the defect as the same user who created it.

1. Open the new defect you just created. (double-click on it).
2. What status is the new defect created with by default?

3. Change the following fields to the defined values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned To</td>
<td>tali_dev</td>
</tr>
<tr>
<td>Detected in Cycle</td>
<td>Cycle 1 – New Features</td>
</tr>
<tr>
<td>Target Cycle</td>
<td>Cycle 1 – New Features</td>
</tr>
<tr>
<td>Severity</td>
<td>3-High</td>
</tr>
</tbody>
</table>

View a linked defect

When a defect is created from Sprinter or the Manual/Automatic Runner, an indirect link is made to the Requirement covered by the failed test. A Business Analyst would want to monitor defects related to a requirement they own. We will continue to stay logged in as the same user to look at the link.

1. Select the Requirements module.
2. Select Requirement Details view.
3. Select the Login requirement within the Profile Maintenance folder.
4. View the Linked Defects tab.
5. The default view for links is to show Direct Links. Change the default to All Links. Confirm you see the defect you created during your test run in an earlier exercise.

Link a defect to a defect

While fixing a defect, a developer may find an additional defect in a shared component. The developer creates a new defect but wants to link this defect to one being worked on.

1. Select the Defects module.
2. Create a New Defect with the details below:
### Field | Value
--- | ---
Summary | Web service truncates accounts coming from XYZ Bank system
Scope Item | Interactive Statements
Severity | 4-Very High

3. Submit the defect and close the window.
4. In the Defect Grid view, highlight the defect you just created.
5. Click the **Linked Entities** tab at the bottom.
6. Within this tab select the **Defects** tab.
7. Click the Link Existing Defect icon.
8. Enter the **Defect Id** for the **Statement truncation** defect you manually created earlier in this exercise.
Using Version Control

**Review Questions**

1. If you want to make changes to an entity in a version enabled project, what is the first thing you must do?
   a. Turn off version control
   b. Check in the entity
   c. Check out the entity
   d. Promote the entity

2. If you would like to revert an entity back to a previous version, which of the following actions do you take?
   a. Check in the entity
   b. Check out the entity
   c. Change the history of the entity
   d. Promote the entity

3. What entities can be versioned?
   a. Tests, Requirements, Test Resources, Components
   b. Releases, Requirements, Tests
   c. Requirements, Tests, Defects
   d. Tests, Requirements, Test Resources, Components, Defects
EXERCISE

User Role:
- Business Analyst
- Quality Analyst

License Type:
- Enterprise
- ALM

Objectives:
- Check out entities
- Check in entities
- Compare versions
- Promote an older version

Login to Version Controlled Project
1. If you are still logged into the OnlineBanking project, logout.
2. Authenticate as:
   Username: peter alm
   Password: training
3. Select the domain Training and project Life_Insurance and login.

Check out an entity
1. Access the Requirements module.
2. Set the view to Requirements Detail.
3. Expand the Screening and Policy folders,
4. Locate the entity in requirements that is currently checked out.
5. How do you know it is checked out?
   ..................................................................................................................
6. Who has it checked out?
   ..................................................................................................................
7. Select the Quote requirement and check it out.
8. Change the **Priority** to **3-High**.
9. How many ways can you find to check out an entity?

..................................................................................................................

10. What is the difference between the requirement you have checked out and the requirement checked out by the other user?

..................................................................................................................

**Check in an entity**

1. Can you check in the requirement checked out by another user?
2. Select the **Quote** requirement you have checked out and check it in.

**Compare versions**

1. Select the **Add Policy** requirement
2. Tab to the right to locate the **History** tab.
3. Select versions 2 and 4 and click the **Compare** button.
4. What is the difference?

..................................................................................................................

**Promote an older version**

1. Select version 2 of the **Add Policy** requirement.
2. Check this version out.
3. Confirm you want to check out the older version.
4. Check the older version **Add Policy** back in.

5. **LOGOUT of THIS PROJECT**
Library Management

Review Questions

1. What does a library contain?
   a. A snapshot of all your entities.
   b. Folder references selected when the library was created.
   c. A snapshot of the entities selected when the library was created.
   d. None of the above

7. When a baseline is pinned to a test set what restrictions are now imposed on this test set?
   a. There are no restrictions
   b. Only tests that cover requirements in the baseline can be added
   c. Only tests included in the baseline can be added
   d. The test set can no longer be modified
EXERCISE

User Role:
- QA Manager

License Type:
- Enterprise
- ALM

Objectives:
- Create a library
- Create a baseline
- Compare a baseline
- Pin a test set to a baseline

Login to OnlineBanking project
1. Authenticate as:
   - Username: alex_adm
   - Password: training
2. Select the domain Training and project OnlineBanking and login.

Create a library
1. Select the Management menu.
2. Select Libraries.
3. Create a new folder called Banking.
4. Select the Create Library icon.
5. Name the library New Features.
6. Expand the Requirements tree on the Requirements tab.
7. Add the Requirements content by checking the Statements, Debit Rewards and Goal Based Savings folders.
8. Select the Tests tab.
9. Select the option to include Tests covering selected requirements.
10. Save the library by clicking OK.
Create a baseline

1. Click the Create baseline icon.
2. After the validation enter Cycle 1 as the Baseline Name.
3. Click OK.
4. Locate and click the View Log button.
5. Review the log.

Compare a baseline

To show how the comparison works, we need to make a change to an entity first.

1. Select the Requirements module.
2. Locate the View Current requirement in the Banking → Statements folder.
3. View the requirement details and change the Priority to 5-Urgent.
4. Return to the Libraries module and select the baseline you created.
5. Select the dropdown for the Compare To icon and select Current Entities (you may need to refresh to enable this icon). Confirm you want to continue
6. When the Compare Baselines Tool displays, expand the Statements folder to view the differences.
7. Select a changed entity and click the Compare Entities icon.
8. Close both comparison tools.

Pin a baseline to a test set

There may be circumstances when test entities need to be updated, but a previous version of them needs to be maintained for testing previous releases or cycles. The baseline can be used to accomplish this.

1. Select the Test Lab module.
2. Select the Goal Based Savings test set you created in an earlier exercise.
3. Review the Execution Grid and note the tests in the set.
4. Click the Details tab.
5. Select the Baseline dropdown and add the Cycle 1 baseline.
6. When you receive the warning that tests not in the baseline will be removed, select Yes to continue.
7. Return to the Execution Grid and click Refresh. Were any tests removed?
8. Was this what you expected?

........................................................................................................................................

9. What is the value of pinning a test set to a baseline?

........................................................................................................................................

........................................................................................................................................

........................................................................................................................................
Sharing Assets

Review Questions

1. A baseline can be compared to which of the following?
   a. Current entities
   b. Another baseline in the same library
   c. A library in another project
   d. All of the above

9. You have initiated synchronization from Project A with Project B. One new entity is found in Project A and two changed entities are found in Project B. What will the synchronization process do?
   a. Add the new entity to Project B, ignore the changes.
   b. Add the new entity to Project B, update the changed entities in Project A.
   c. Update the changed entities in Project A.
   d. Add the new entity to Project A.
EXERCISE

User Role:
- QA Manager

License Type:
- ALM

Objectives:
- Import a library from another project
- Compare libraries
- Synchronize libraries

Login to Life_Insurance project
1. Authenticate as:
   Username: alex_adm
   Password: training
2. Select the domain Training and project Life_Insurance and login.

Import a library from another project
1. Review the Requirements and Test trees to confirm they are empty.
2. Select the Libraries module.
3. Create a Folder named Common.
4. Select the Import Library icon.
5. Select the From Project option and select with the criteria below:
   Domain: Training
   Project: Auto_Insurance
   Baseline: ContactStds
2. Step through the process until prompted for the root folders to import to.
3. Select the Root Folders for both Requirements and Tests and select Finish.
4. Check the Requirements and Tests modules to see if the new Folders were added.
5. Add a new Requirement in the Contact folder called Site Map, enter all required fields.
6. Go to the Libraries module.
7. Select the library you just imported.
8. Add a new baseline (you may need to refresh to enable this button).
9. Name the new baseline: Changes <todays_date>

Compare libraries

Since you cannot “PUSH” the library changes, we will change to the Auto_Insurance project for comparing and synchronizing.

1. Use the shortcut to change to the Auto_Insurance project by selecting the Tools → Change Project → Select… menu.
2. Login to the Auto_Insurance project.
3. Go to the Libraries module.
4. Place the cursor on the Contact library
5. Select the Compare To… → Latest Baseline Created option.
6. The baseline list you can select from is automatically defaulted to the baselines available in the library you imported from. Select the ContactStds baseline.
7. Expand the contents of the libraries shown in the Compare Libraries Tool.
8. What indicators let you know the library has changed?

Synchronize libraries

1. While still in the Compare Libraries Tool, select the Synchronize icon.
2. Continue through the Synchronization steps.
3. When complete, confirm the new Requirement added in the Life_Insurance project is added to the Auto_Insurance requirements.
Reporting and Analysis

Review Questions

1. Which report types can be added to the Dashboard?
   a. Project Reports and Graphs
   b. Graphs and Scorecards
   c. Any report type
   d. Excel Reports and Graphs

2. Which report type allows you to use custom templates?
   a. Project Reports
   b. Standard Reports
   c. Any report type
   d. None of the report types

3. What type of report can be shared to an external portal directly from ALM?
   a. Project Reports and Graphs
   b. Any report type
   c. Excel Reports and Graphs
   d. Graphs and Scorecards
EXERCISE

User Role:
- Project Manager
- QA Manager

License Type:
- Enterprise
- ALM

Objectives:
- Review release progress and quality
- Generate Project Planning and Tracking Scorecard
- Review the Scorecard
- Create a Project Report
- Create Graphs
- Build a Dashboard
- Create a Cross-Project graph

Login to OnlineBanking project
1. Authenticate as:
   - Username: alex_adm
   - Password: training
2. Select the domain Training and project OnlineBanking and login.

Review release progress and quality
Now that we have created and linked tests, executed tests and created defects we can review the progress and quality of our release. There is still limited information as we are early in the release, but this is where customers with the Enterprise Edition can review the progress and quality of the release.
1. Select the Releases module.
2. Place the cursor on Banking 4.0 Release
3. Select the Status tab.
4. View the Progress and Quality tabs
Generate Planning and Tracking Scorecard

The ALM customers can track the performance of the release by tracking the KPIs on the Scorecard. The Scorecard KPIs are calculated once a day. In a customer environment this should be sufficient. We will need to force a new calculation so you can review the latest data.

1. Open a new tab on the browser.
2. Click the **HP ALM 11.00 link** on the browser toolbar.
3. Select the **Site Administration link**.
4. Login as:
   - **User**: admin
   - **Password**: training
4. Select the **Site Projects tab**.
5. Expand the **TRAINING Domain**.
6. Expand the **Projects** tree.
7. Select the **OnlineBanking** project.
8. Locate the **Run Now** button on the Project Details tab and click it. You are now rerunning the PPT calculations.
9. Logout of Site Administration.
10. Return to the Application Lifecycle Management browser session.

Review the Scorecard

1. Select the Releases module.
2. Click the **Scorecard** tab.
3. Check the bottom of the scorecard. When was the last update? (you may need to refresh)

   ..................................................................................................................

4. What data is available?
5. We have executed tests in an earlier exercise. Do you know why the Tests Executed KPI is still reporting 0/0?

   ..................................................................................................................

Create a Project Report

1. Expand the Dashboard menu.
2. Select the **Analysis View** module.
3. Select the **Public** folder.
4. Create a new folder called **Reports**.
5. Click the **New Item dropdown** to add a **New Project Report**.
6. Name the report: **Severe Defects**.
7. On the Configuration tab, click the **Add Report Section** icon.
8. Select **Defects** as the **Type** and **Name**, click OK.
9. Select **Defect Tabular Template** as the **Project Template**.
10. Locate and select the filter icon.
11. Set the **Severity** to: 4-Very High or 5-Urgent. Also set the **Status** to Open or New or Rejected or Reopen.
12. Generate and review the report.
13. Close the browser tab the report opened in.

**Create Graphs**

1. Select the **Public** folder.
2. Create a new folder called **Graphs**.
3. Click the **New Item dropdown** to add a **New Graph**.
4. Select **Defects** as the **Entity**, **Summary Graph** as the **Graph Type** and **Severe Defects** as the **Name**. Click OK.
5. Change the **X-Axis** setting to **Status**.
6. Locate and select the filter icon.
7. Set the **Severity** to: 4-Very High or 5-Urgent. Also set the **Status** to Open or New or Rejected or Reopen.
8. View the graph.
9. Create another new graph with the following details:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity</td>
<td>Tests</td>
</tr>
<tr>
<td>Graph Type</td>
<td>Summary</td>
</tr>
<tr>
<td>Name</td>
<td>Test Execution Summary</td>
</tr>
<tr>
<td>X-Axis</td>
<td>Execution Status</td>
</tr>
<tr>
<td>Grouped by</td>
<td>Status</td>
</tr>
</tbody>
</table>
Create an Analysis Graph

1. Select the Public → Graphs folder.
3. Enter Banking 4.0 Scorecard as the Graph Name.
4. Select Banking 4.0 as the Release on the Configuration tab.
5. Accept defaults.
6. Click View. The Scorecard should look as it did when you reviewed it in the Releases module.

Create a Dashboard

1. Select the Dashboard View module.
2. Select the Public folder.
3. Click the New Page icon.
4. Enter Banking 4.0 as the Page Name.
5. Select the Configuration tab.
6. In the Graphs Tree to the right, select the Severe Defects graph and add it to the page.
7. Add Test Summary graph.
8. Add the Banking 4.0 Scorecard graph.
9. Configure the layout to look like the sample below:

![Dashboard Layout Sample]

10. View the dashboard.

Create a Cross-Project graph

This feature is for ALM customers ONLY.

1. Select the Analysis View module.
2. Select the **Public ➔ Graphs** folder.

3. Click the **New Item dropdown** to add a **New Graph**.

4. Select **Defects** as the **Entity**, **Summary Graph** as the **Graph Type** and **Cross Project Severe Defects** as the **Name**. Click **OK**.

5. Change the **X-Axis** setting to **ALM Projects**.

6. Change **Grouped by** to **Severity**.

7. In the Project Selection below, click the **Select Projects** button.

8. Add projects **Auto_Insurance** and **Life_Insurance** from the **Training** domain.

9. View the graph.